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Security 
informa-
tion 

Siemens provides products and solutions with industrial security functions that 
support the secure operation of plants, systems, machines and networks. 
In order to protect plants, systems, machines and networks against cyber 
threats, it is necessary to implement – and continuously maintain – a holistic, 
state-of-the-art industrial security concept. Siemens’ products and solutions only 
form one element of such a concept. 
Customer is responsible to prevent unauthorized access to its plants, systems, 
machines and networks. Systems, machines and components should only be 
connected to the enterprise network or the internet if and to the extent necessary 
and with appropriate security measures (e.g. use of firewalls and network 
segmentation) in place.  
Additionally, Siemens’ guidance on appropriate security measures should be 
taken into account. For more information about industrial security, please visit 
http://www.siemens.com/industrialsecurity. 

Siemens’ products and solutions undergo continuous development to make them 
more secure. Siemens strongly recommends to apply product updates as soon 
as available and to always use the latest product versions. Use of product 
versions that are no longer supported, and failure to apply latest updates may 
increase customer’s exposure to cyber threats. 
To stay informed about product updates, subscribe to the Siemens Industrial 
Security RSS Feed under http://www.siemens.com/industrialsecurity. 
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1 Introduction 
This document shows you how to exchange data between an S7-1200 and an 
S7-300 using S7 Communication. 

The SIMATIC S7-1200 is configured in STEP 7 V16 (TIA Portal V16).  

The SIMATIC S7-300 can be configured in STEP 7 V16 (TIA Portal V16) or in 
STEP 7 V5.6. 

Two S7 connections are established. 

For the first S7 connection the S7-300 acts as a client and the S7-1200 as server. 
This means that the S7-300 actively establishes the connection. The function 
blocks "GET" and "PUT" are called in the user program of the S7-300 to read data 
from the S7-1200 and write data to the S7-1200. 

For the second S7 connection the S7-1200 acts as a client and the S7-300 as 
server. This means that the S7-1200 actively establishes the connection. The 
instructions "GET" and "PUT" are called in the user program of the S7-1200 to read 
data from the S7-300 and write data to the S7-300. 

 

Figure 1-1 

S7-300 S7-1200

S7 Connection: ID 16#1Client:

PUT/GET

S7 Connection: ID 16#100 Client:

PUT/GETServer

Server

 

 



2 Configuration of SIMATIC S7-1200 

 

S7 communication between SIMATIC S7-1200 and SIMATIC S7-300 
with PUT/GET 
Entry-ID: 82212115,    V 3.0,    11/2020   6 
 

©
 S

ie
m

e
n

s
 A

G
 2

0
2

0
 A

ll 
ri

g
h

ts
 r

e
s
e

rv
e

d
 

2 Configuration of SIMATIC S7-1200 
1. Create a new project or open an existing project in STEP 7 V16 

(TIA Portal V16). 

2. Add the S7-1200 CPU and create the hardware configuration. 

3. Install the S7-1200 CPU as client or server. 

– Client: Configure a new S7 connection and create the user program. In the 
user program you call the "PUT" instruction to write data to the S7-300 
CPU. In the user program you call the "GET" instruction to read data from 
the S7-300 CPU. Add the data blocks for saving the Send and Receive 
data. 

– Server: Create the user program. In the user program you add data blocks 
in which the sent and received data is stored. 

2.1 Create the Hardware Configuration 

2.1.1 Set the IP address of the CPU 

1. In the Device view or Network view of the “Devices & networks" editor you 
mark the S7-1200 CPU. 
The properties of the S7-1200 CPU are displayed in the inspector window. 

2. In the "General" tab under "PROFINET interface [X1] > Ethernet addresses" 
you enter the IP address and the subnet mask of the S7-1200 CPU. 

– IP address: 172.16.43.2 

– Subnet mask: 255.255.0.0 

3. Assign a subnet to the Ethernet interface of the S7-1200 CPU. You have two 
options: 

– Click the "Add new subnet" button to add a new subnet. 

– Select an existing subnet. 
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2.1.2 Set the IP address of the CP 

1. In the Device view or Network view of the “Devices & networks" editor you 
mark the CP in the S7-1200. 
The properties of the CP are displayed in the inspector window. 

2. In the "General" tab under "Ethernet interface [X1] > Ethernet addresses" you 
enter the IP address and the subnet mask of the CP. 

– IP address: 172.16.43.40 

– Subnet mask: 255.255.0.0 

3. Assign a subnet to the Ethernet interface of the CP. You have two options: 

– Click the "Add new subnet" button to add a new subnet. 

– Select an existing subnet. 

 

 



2 Configuration of SIMATIC S7-1200 

 

S7 communication between SIMATIC S7-1200 and SIMATIC S7-300 
with PUT/GET 
Entry-ID: 82212115,    V 3.0,    11/2020   8 
 

©
 S

ie
m

e
n

s
 A

G
 2

0
2

0
 A

ll 
ri

g
h

ts
 r

e
s
e

rv
e

d
 

2.1.3 Permit Access with PUT/GET Communication from Remote Partner 

In the S7-1200 CPU you enable the function "Permit access with PUT/GET 
communication from remote partner”. This enables the partner CPU to access the 
data in the S7-1200 CPU using the "PUT" and "GET" instructions. 

1. In the Device view or Network view of the “Devices & networks" editor you 
mark the S7-1200 CPU. 
The properties of the S7-1200 CPU are displayed in the inspector window. 

2. In the "General" tab, under "Protection & Security > Connection mechanisms" 
you enable the "Permit access with PUT/GET communication from remote 
partner" function. 

 

2.1.4 Enable S7 communication to the CPU 

With the S7-1200, enable S7 communication to the CPU in the CP. In order to 
release the function of S7 communication with the assigned CPU and the S7 
routing.  

If you configure an S7 connection that runs via the CP of the S7-1200, then you 
have to activate this option. 

1. In the Device view or Network view of the “Devices & networks” editor you 
mark the CP in the S7-1200. 

2. In the "General" tab, under "Communication types" you enable the "Enable S7 
communication to the CPU" option. 
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2.2 Install SIMATIC S7-1200 as Client 

2.2.1 Configuration of the S7 Connection 

1. In the Network view you click the "Connections" icon to enable the Connection 
mode. 

2. Select "S7 connection" as the connection type in the adjacent drop-down list 
box. 
In the Network view, all devices that are available for an S7 connection are 
highlighted in color. 

3. Right-click the S7-1200 CPU. The pop-up menu opens. 

4. Select the "Add new connection" item. 
The "Add new connection" dialog opens. 

 

5. Specify the following connection partner: "Unspecified". 

6. Select the local interface. In this example, the integrated interface of the 
S7-1200 CPU is used. If the S7 connection is to be established via a CP, 
select the CP. 

7. Enter the local ID for the S7 connection, 100 (hex), for example. 

8. Click the "Add" button to add the unspecified S7 connection. 

9. Click the "Close" button to end the dialog. 
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Result 

• An unspecified S7 connection is created. 

• The connection path is displayed highlighted in the graphical area of the 
Network view. 

 
 

• The S7 connection is entered in the "Connections" table in the table area of the 
Network view. 
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Setting the connection parameters 

1. In the “Connections” table, mark the unspecified S7 connections. 
The Properties of the S7 connection are displayed in the inspector window. 

2. Under "General" the "General" tab displays the general connection parameters 
that identify the local endpoint. Under Partner you enter the IP address of the 
S7-300 CPU, for example: 172.16.43.37. If you use a CP as partner instead of 
the integrated interface of the S7-300 CPU, enter the IP address of the CP. 

 

3. In the “General” tab under “Local ID” you see the local ID of the module from 
which the connection is viewed (local partner). You can change the local ID. 
You specify the local ID later at the "ID" input parameter of the "PUT" or "GET" 
instruction. 
In this example we use the local ID with the value 100 (hex). 

 



2 Configuration of SIMATIC S7-1200 

 

S7 communication between SIMATIC S7-1200 and SIMATIC S7-300 
with PUT/GET 
Entry-ID: 82212115,    V 3.0,    11/2020   12 
 

©
 S

ie
m

e
n

s
 A

G
 2

0
2

0
 A

ll 
ri

g
h

ts
 r

e
s
e

rv
e

d
 

4. In the "General" under "Special connection properties" you see that the S7 
connection is configured unilaterally. Unilaterally means that the connection 
partner is server for this connection and cannot actively send or receive. The 
S7 CPU that is used as the local endpoint for the S7 connection, actively 
establishes the S7 connection as a client and actively sends and receives. 

 

 

5. In the "General" tab under "Address details” you enter the partner TSAP. Since 
the S7 connection is configured unilaterally to an unspecified partner, the 
partner TSAP is composed as follows: 
03 <slot of CPU or CP >, for example: 

– S7-300 CPU in slot 2: 03.02 
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2.2.2 Create Send and Receive Data Areas 

Add data block for saving the Receive data 

The data received from the S7-300 CPU is stored in data block 
DB1 "RecvDataClient" of the S7-1200 CPU. 

1. In the project tree you navigate to the device folder of the S7-1200 CPU. 
The device folder contains structured objects and actions that belong to the 
device. 

2. In the device folder you navigate to the "Program blocks" subfolder and 
double-click the "Add new block" action. 
The "Add new block" dialog opens. 

Unrestricted

 

3. Click the "Data block (DB)" button. 

4. Enter the name of the data block (DB), "RecvDataClient", for example. 

5. Enable the "Automatic" option to have the number of the DB assigned 
automatically by STEP 7. 

6. Enable the "Add new and open" function. 

7. Click the "OK" button to apply the settings and close the dialog. 

– In the project tree the "RecvDataClient" DB is added to the "Program 
blocks" folder of the S7-1200 CPU. 

– If the "Add new and open" function is enabled, the "RecvDataClient" DB 
opens in the working area of STEP 7 V16. 
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8. Alternatively, you can open the "RecvDataClient" DB in the working area of 
STEP 7 V16 by going in the project tree to the "Program blocks" folder of the 
S7-1200 CPU and double-clicking the "RecvDataClient" DB. 
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9. In the DB "RecvDataClient” you define the variable "data" of the data type 
Array[0..199] of Byte. 

 

10. In the Properties of the DB1 "RecvDataClient”, under "Attributes" you disable 
the "Optimized block access" function. 

10

 

 

Add data block for saving the Send data 

The data that is transferred to the S7-300 CPU is stored in data block 
DB2 "SendDataClient" of the S7-1200 CPU. 

1. Add another DB for saving the Send data. 

2. In the "Add new block" dialog you click the "Data block (DB)" button. 

3. Enter the name of the DB, "SendDataClient", for example. 

4. Enable the "Automatic" option to have the number of the DB assigned 
automatically by STEP 7. 

5. Enable the "Add new and open" function. 

6. Click the "OK" button to apply the settings and close the dialog. 

– In the project tree the "SendDataClient" DB is added to the "Program 
blocks" folder of the S7-1200 CPU. 

– If the "Add new and open" function is enabled, the "SendDataClient" DB 
opens in the working area of STEP 7 V16. 
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7. Alternatively, you can open the "SendDataClient" DB in the working area of 
STEP 7 V16 by going in the project tree to the "Program blocks" folder of the 
S7-1200 CPU and double-clicking the "SendDataClient" DB. 
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8. In the DB "SendDataClient” you define the variable "data" of the data type 
“Array[0..199] of Byte”. 

 

9. In the Properties of DB1 "SendDataClient”, under "Attributes" you disable the 
"Optimized block access" function. 

 

 

2.2.3 Create Variables for Parameters of Function Blocks "PutData" and 
"GetData" 

1. Add another DB to create variables for the parameters of function blocks 
"PutData" and "GetData". 

2. In the "Add new block" dialog you click the "Data block (DB)" button. 

3. Enter the name of the DB, "GeneralData", for example. 

4. Enable the "Automatic" option to have the number of the DB assigned 
automatically by STEP 7. 

5. Enable the "Add new and open" function. 

6. Click the "OK" button to apply the settings and close the dialog. 

– In the project tree the "GeneralData" DB is added to the "Program blocks" 
folder of the S7-1200 CPU. 

– If the "Add new and open" function is enabled, the "GeneralData" DB 
opens in the working area of STEP 7 V16. 
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7. Alternatively, you can open the "GeneralData" DB in the working area of 
STEP 7 V16 by going in the project tree to the "Program blocks" folder of the 
S7-1200 CPU and double-clicking the "GeneralData" DB. 

 

8. Create the following variables to assign the input and output parameters of the 
FBs "PutData" and "GetData". PLC data types are used as data type. 

Variable PLC data type Description 

put typePut Variables for parameterizing FB12 "PutData”. 

get typeGet Variables for parameterizing FB13 "GetData”. 

diagnostic typeDiagnostic Variables to store the status of FBs "PutData" and 
"GetData" in case of error. 

 

 



2 Configuration of SIMATIC S7-1200 

 

S7 communication between SIMATIC S7-1200 and SIMATIC S7-300 
with PUT/GET 
Entry-ID: 82212115,    V 3.0,    11/2020   19 
 

©
 S

ie
m

e
n

s
 A

G
 2

0
2

0
 A

ll 
ri

g
h

ts
 r

e
s
e

rv
e

d
 

PLC Data Type "typePut" 

The following table shows the structure of "typePut” data type. 

Table 2-1 

Parameter Data type Start value Description 

execute Boolean false Control parameter for FB12 "PutData". 

connectionId Word 16#0 Addressing parameter for specifying 
the connection to the communication 
partner. 

done Boolean false Status parameters 

busy Boolean false Status parameters 

error Boolean false Status parameters 

status Word 16#0 Status parameters 

 

PLC Data Type "typeGet" 

The following table shows the structure of the PLC data type "typeGet". 

Table 2-2 

Parameter Data type Start value Description 

execute Boolean false Control parameter for FB13 "GetData". 

connectionId Word 16#0 Addressing parameter for specifying 
the connection to the communication 
partner. 

done Boolean false Status parameters 

busy Boolean false Status parameters 

error Boolean false Status parameters 

status Word 16#0 Status parameters 

 

PLC Data Type "typeDiagnostic" 

The following table shows the structure of the "typeDiagnostic" data type. 

Table 2-3 

Parameter Data type Start value Description 

statusPut Word 16#0 Parameter to store the status of 
FB12 "PutData”. 

statusGet Word 16#0 Parameter to store the status of 
FB13 "GetData”. 

 



2 Configuration of SIMATIC S7-1200 

 

S7 communication between SIMATIC S7-1200 and SIMATIC S7-300 
with PUT/GET 
Entry-ID: 82212115,    V 3.0,    11/2020   20 
 

©
 S

ie
m

e
n

s
 A

G
 2

0
2

0
 A

ll 
ri

g
h

ts
 r

e
s
e

rv
e

d
 

2.2.4 Create a User Program 

Overview 

The following figure shows an overview of the user program in the S7-1200 CPU 
and S7-300 CPU. 

Figure 2-1 

User

program

Instructions

Data blocks

Data blocks

Write

data

Read

data

S7-1200 CPU

S7-300 CPU

Main [OB1] 

PutData

[FB12]

GetData

[FB13]

PUT GET

SendData

Client [DB2]

RecvData

Client [DB1]

RecvData
Server 
[DB3]

SendData
Server 
[DB4]
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FB12 "PutData” 

The FB12 "PutData" calls the "PUT" instruction to execute the following functions: 

• Send data to the partner via the configured connection as soon as the input 
"execute" recognizes a positive edge. When the Write job is running, it is not 
possible to trigger a new Write job. 

• Output the status of the FB and data transmission at the "status" output. 

 

FB12 "PutData” is called cyclically in OB1. 

The following figure shows the call of the FB12 "PutData” in OB1. 

Figure 2-2 
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The following table shows the parameters of FB12 "PutData". 

Table 2-4 

Name P type Data 
type 

Comment 

execute IN Bool Control parameter: 

Enables the Write job on a rising edge. 

connectionId IN Word Local ID: 

Addressing parameter for specifying the connection to the partner 
CPU. 

Note 
The local ID is available in the Properties of the configured S7 
connection. 

The local ID 100 (hex) is used in this example. 

done OUT Bool TRUE: The Write job was executed error-free. 

busy OUT Bool TRUE: The Write job is running. 

error OUT Bool Status parameters "error" and "status": 

• "error" = 0: 

– "status" = 0000 (hex): neither warning nor error 

– "status" <> 0000 (hex): Warning 
The "status" parameter provides detailed information. 

• "error" = 1: An error has occurred. 
The "status" parameter provides detailed information about 
the type of error. 

status OUT Word 

ADDR_1 IN_OUT Remote Pointer to the area to be written to in the partner CPU. 

Note 
The following parameters are hidden and are preset with the 
value "NULL”: 

• "ADDR_2" 

• "ADDR_3" 

• "ADDR_4" 

The following minimum user data size for the “PUT” instruction 
with 1 – 4 variables is guaranteed: 160 bytes 

ADDR_2 IN_OUT Remote 

ADDR_3 IN_OUT Remote 

ADDR_4 IN_OUT Remote 

SD_1 IN_OUT Variant Pointer to the area in your own S7 CPU that contains the data to 
be sent. 

Note 
The following parameters are hidden and are preset with the 
value "NULL”: 

• "SD_2" 

• "SD_3" 

• "SD_4" 

The following minimum user data size for the “PUT” instruction 
with 1 – 4 variables is guaranteed: 160 bytes 

SD_2 IN_OUT Variant 

SD_3 IN_OUT Variant 

SD_4 IN_OUT Variant 
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Assign the variables created in section 2.2.3 to the parameters of FB12 "PutData”. 

The following table shows the assignment of the parameters of the "put” variable to 
the parameters of FB12 "PutData”. 

Table 2-5 

Parameters of 
FB12 "PutData" 

Parameters 
of the "put" 

variable 

Start value Note 

execute execute false Set the "execute” parameter to the 
value "TRUE" to start the Write 
job. The Write job is started on a 
rising edge. Reset the "execute" 
parameter to the value "FALSE" if 
the Write job is completed with 
"done" = true or "error" = true. 

connectionId connectionId 16#100 Enter the local ID of the 
connection that you defined during 
the connection configuration. 

done done false − 

busy busy false − 

error error false − 

status status 16#0 − 

ADDR_1 − P#DB1.DBX0.0 
BYTE 100. 

Only absolute addressing is 
permitted. 

SD_1 − P#DB2.DBX0.0 
BYTE 100 

− 
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FB13 "GetData" 

The FB13 "GetData" calls the "GET" instruction to execute the following functions: 

• Receive data from the partner via the configured connection as soon as the 
input "execute" recognizes a positive edge. When the Read job is running, it is 
not possible to trigger a new Read job. 

• Output the status of the FB and data transmission at the "status" output. 

 

FB13 "GetData” is called cyclically in OB1. 

The following figure shows the call of the FB13 "GetData” in OB1. 

Figure 2-3 
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The following table shows the parameters of FB13 "GetData”. 

Table 2-6 

Name P type Data type Comment 

execute IN Bool Control parameter: 

Enables the Read job on a rising edge. 

connectionId IN Word Local ID: 

Addressing parameter for specifying the connection to the 
partner CPU. 

Note 
The local ID is available in the Properties of the configured S7 
connection. 

The local ID 100 (hex) is used in this example. 

done OUT Bool TRUE: The Read job was executed error-free. 

busy OUT Bool TRUE: The read job is running. 

error OUT Bool Status parameters "error" and "status": 

• "error" = 0: 

– "status" = 0000 (hex): neither warning nor error 

– "status" <> 0000 (hex): Warning 
The "status" parameter provides detailed information. 

• "error" = 1: An error has occurred. 
The "status" parameter provides detailed information about 
the type of error. 

status OUT Word 

ADDR_1 IN_OUT Remote Pointer to the area to be read in the partner CPU. 

Note 
The following parameters are hidden and are preset with the 
value "NULL”: 

• "ADDR_2" 

• "ADDR_3" 

• "ADDR_4" 

The following minimum user data size for the “GET” instruction 
with 1 – 4 variables is guaranteed: 160 bytes 

ADDR_2 IN_OUT Remote 

ADDR_3 IN_OUT Remote 

ADDR_4 IN_OUT Remote 

RD_1 IN_OUT Variant Pointer to the area in your own S7 CPU in which the read data 
is stored. 

Note 
The following parameters are hidden and are preset with the 
value "NULL”: 

• "RD_2" 

• "RD_3" 

• "RD_4" 

The following minimum user data size for the “GET” instruction 
with 1 – 4 variables is guaranteed: 160 bytes 

RD_2 IN_OUT Variant 

RD_3 IN_OUT Variant 

RD_4 IN_OUT Variant 
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Assign the variables created in section 2.2.3 to the parameters of FB13 "GetData”. 

The following table shows the assignment of the parameters of the "get” variable to 
the parameters of FB13 "GetData”. 

Table 2-7 

Parameters of 
FB13 "GetData" 

Parameters 
of the "get" 

variable 

Start value Note 

execute execute false Set the "execute” parameter to the 
value "TRUE" to start the Read job. 
The Read job is started on a rising 
edge. Reset the "execute" 
parameter to the value "FALSE" if 
the Read job is completed with 
"done" = true or "error" = true. 

connectionId connectionId 16#100 Enter the local ID of the connection 
that you defined during the 
connection configuration. 

done done false − 

busy busy false − 

error error false − 

status status 16#0 − 

ADDR_1 − P#DB4.DBX0.0 
BYTE 100 

Only absolute addressing is 
permitted. 

RD_1 − P#DB1.DBX0.0 
BYTE 100 

− 
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2.3 Install SIMATIC S7-1200 as Server 

2.3.1 Create Send and Receive Data Areas 

In the user program of the S7-1200 CPU you add the data blocks for saving the 
Send and Receive data. 

Add data block for saving the Receive data 

1. In the project tree you navigate to the device folder of the S7-1200 CPU. 
The device folder contains structured objects and actions that belong to the 
device. 

2. In the device folder you navigate to the "Program blocks" subfolder and 
double-click the "Add new block" action. 
The "Add new block" dialog opens. 

Unrestricted

 

3. Click the "Data block (DB)" button. 

4. Enter the name of the data block (DB), "RecvDataServer", for example. 

5. Enable the "Automatic" option to have the number of the DB assigned 
automatically by STEP 7. 

6. Enable the "Add new and open" function. 

7. Click the "OK" button to apply the settings and close the dialog. 

– In the project tree the "RecvDataServer" DB is added to the "Program 
blocks" folder of the S7-1200 CPU. 

– If the "Add new and open" function is enabled, the "RecvDataServer" DB 
opens in the working area of STEP 7 V16. 
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8. Alternatively, you can open the "RecvDataServer" DB in the working area of 
STEP 7 V16 by going in the project tree to the "Program blocks" folder of the 
S7-1200 CPU and double-clicking the "RecvDataServer" DB. 
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9. In the DB "RecvDataServer” you define the variable "data" of the data type 
“Array[0..199] of Byte”. 

 

 

10. Because the communication partner, SIMATIC S7-300, for example, does not 
support DBs with optimized block access, you have to disable the "Optimized 
block access" option under "Attributes" in the Properties of the DB. 
DBs with standard access have a fixed structure. The data elements in the 
declaration include both a symbolic name and a fixed address in the block. The 
address is displayed in the "Offset" column. You can address the variables in 
this block both symbolically and absolutely. 

10
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Add data block for saving the Send data 

1. Add another DB for saving the Send data. 

2. In the "Add new block" dialog you click the "Data block (DB)" button. 

3. Enter the name of the DB, "SendDataServer", for example. 

4. Enable the "Automatic" option to have the number of the DB assigned 
automatically by STEP 7. 

5. Enable the "Add new and open" function. 

6. Click the "OK" button to apply the settings and close the dialog. 

– In the project tree the "SendDataServer" DB is added to the "Program 
blocks" folder of the S7-1200 CPU. 

– If the "Add new and open" function is enabled, the "SendDataServer" DB 
opens in the working area of STEP 7 V16. 
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7. Alternatively, you can open the "SendDataServer" DB in the working area of 
STEP 7 V16 by going in the project tree to the "Program blocks" folder of the 
S7-1200 CPU and double-clicking the "SendDataServer" DB. 

 

8. In the DB "SendDataServer” you define the variable "data" of the data type 
“Array[0..199] of Byte”. 

 

 

9. Because the communication partner, SIMATIC S7-300, for example, does not 
support DBs with optimized block access, you have to disable the "Optimized 
block access" option under "Attributes" in the Properties of the DB. 
DBs with standard access have a fixed structure. The data elements in the 
declaration include both a symbolic name and a fixed address in the block. The 
address is displayed in the "Offset" column. You can address the variables in 
this block both symbolically and absolutely. 
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2.4 Download the Hardware Configuration and User 
Program 

Requirements 

You have already assigned the configured IP address and subnet mask to the 
S7-1200 CPU and possibly the CP. 

Compile 

10. In the project tree you mark the device folder of the S7-1200 CPU. 

11. Click the "Compile" button in the toolbar. The hardware configuration and the 
software of the S7-1200 are compiled. 
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Download 

1. In the project tree you mark the device folder of the S7-1200 CPU. 

2. Click the "Download to device" button in the toolbar. The "Extended download 
to device" or "Load preview" dialog opens automatically. 

 

3. The "Extended download to device" dialog opens automatically only if the 
access path from the PG/PC to the S7-1200 CPU has to be set. Make the 
following settings: 

– Type of the PG/PC interface: PN/IE 

– PG/PC interface: Network card of the PG/PC 

– Connection to interface/subnet: Subnet to which the S7-1200 CPU is 
connected 

4. In the drop-down list box, you select "Show all compatible devices". 

5. Click "Start Search". 

6. The S7-1200 CPU is displayed in the "Select target device:" list. Mark the 
S7-1200 CPU. 

7. Click the "Load" button. 
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8. In the "Load preview" dialog you click the "Load" button to start the loading 
procedure. 

 



2 Configuration of SIMATIC S7-1200 

 

S7 communication between SIMATIC S7-1200 and SIMATIC S7-300 
with PUT/GET 
Entry-ID: 82212115,    V 3.0,    11/2020   36 
 

©
 S

ie
m

e
n

s
 A

G
 2

0
2

0
 A

ll 
ri

g
h

ts
 r

e
s
e

rv
e

d
 

9. In the "Load results" dialog you enable the "Start module" action and click the 
"Finish" button to terminate the loading procedure. 
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3 Configuration of SIMATIC S7-300 in 
STEP 7 V16 
1. Create a new project or open an existing project in STEP 7 V16 (TIA Portal 

V16). 

2. Add the S7-300 CPU and create the hardware configuration. 

3. Install the S7-300 CPU as client or server. 

– Client: Configure a new S7 connection and create the user program. In the 
user program you call the "PUT" instruction to write data to the S7-1200 
CPU. In the user program you call the "GET" instruction to read data from 
the S7-1200 CPU. Add the data blocks for saving the Send and Receive 
data. 

– Server: Create the user program. In the user program you add data blocks 
in which the sent and received data is stored. 

3.1 Create the Hardware Configuration 

3.1.1 Set the IP address of the CPU 

1. In the Device view or Network view of the “Devices & networks" editor you 
mark the S7-300 CPU. 
The properties of the S7-300 CPU are displayed in the inspector window. 

2. In the "General" tab under "PROFINET interface [X1] > Ethernet addresses" 
you enter the IP address and the subnet mask of the S7-300 CPU. 

– IP address: 172.16.43.37 

– Subnet mask: 255.255.0.0 

3. Assign a subnet to the Ethernet interface of the S7-300 CPU. You have two 
options: 

– Click the "Add new subnet" button to add a new subnet. 

– Select an existing subnet. 
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3.1.2 Set the IP address of the CP 

1. In the Device view or Network view of the “Devices & networks" editor you 
mark the CP in the S7-300. 
The properties of the S7-300 CPU are displayed in the inspector window. 

2. In the "General" tab under "PROFINET interface [X1] > Ethernet addresses" 
you enter the IP address and the subnet mask of the CP. 

– IP address: 172.16.43.41 

– Subnet mask: 255.255.0.0 

3. Assign a subnet to the Ethernet interface of the CP. You have two options: 

– Click the "Add new subnet" button to add a new subnet. 

– Select an existing subnet. 
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3.2 Install SIMATIC S7-300 as Client 

3.2.1 Configuration of the S7 Connection 

1. In the Network view you click the "Connections" icon to enable the Connection 
mode. 

2. Select "S7 connection" as the connection type in the adjacent drop-down list 
box. 
In the Network view, all devices that are available for an S7 connection are 
highlighted in color. 

3. Right-click the S7-1200 CPU. The pop-up menu opens. 

4. Select the "Add new connection" item. 
The "Add new connection" dialog opens. 

 

5. Specify the following connection partner: "Unspecified". 

6. Select the local interface. In this example, the integrated interface of the 
S7-300 CPU is used. If the S7 connection is to be established via a CP, select 
the CP. 

7. Enter the local ID for the S7 connection, 1 (hex), for example. 

8. Click the "Add" button to add the unspecified S7 connection. 

9. Click the "Close" button to end the dialog. 
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Result 

• An unspecified S7 connection is created. 

• The connection path is displayed highlighted in the graphical area of the 
Network view. 

 

 

• The S7 connection is entered in the "Connections" table in the table area of the 
Network view. 
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Setting the connection parameters 

1. In the “Connections” table, mark the unspecified S7 connections. 
The Properties of the S7 connection are displayed in the inspector window. 

2. Under "General" the "General" tab displays the general connection parameters 
that identify the local endpoint. Under Partner you enter the IP address of the 
S7-1200 CPU, for example: 172.16.43.2. If you use a CP as partner instead of 
the integrated interface of the S7-1200 CPU, enter the IP address of the CP. 

 

3. In the “General” tab under “Local ID” you see the local ID of the module from 
which the connection is viewed (local partner). You can change the local ID. 
You specify the local ID later at the "ID" input parameter of the "PUT" or "GET" 
instruction. 
In this example we use the local ID with the value 1 (hex). 
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4. In the "General" under "Special connection properties" you see that the S7 
connection is configured unilaterally. Unilaterally means that the connection 
partner is server for this connection and cannot actively send or receive. The 
S7 CPU that is used as the local endpoint for the S7 connection, actively 
establishes the S7 connection as a client and actively sends and receives. 

 

5. In the "General" tab under "Address details” you enter the partner TSAP. Since 
the S7 connection is configured unilaterally to an unspecified partner, the 
partner TSAP is composed as follows: 
03 <slot of CPU or CP>, for example: 

– S7-1200 CPU in slot 1: 03.01 
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3.2.2 Create Send and Receive Data Areas 

Add data block for saving the Receive data 

The data received from the S7-1200 CPU is stored in data block 
DB1 "RecvDataClient" of the S7-300 CPU. 

1. In the project tree you navigate to the device folder of the S7-300 CPU. 
The device folder contains structured objects and actions that belong to the 
device. 

2. In the device folder you navigate to the "Program blocks" subfolder and 
double-click the "Add new block" action. 
The "Add new block" dialog opens. 

Unrestricted

 

3. Click the "Data block (DB)" button. 

4. Enter the name of the data block (DB), "RecvDataClient", for example. 

5. Enable the "Automatic" option to have the number of the DB assigned 
automatically by STEP 7. 

6. Enable the "Add new and open" function. 

7. Click the "OK" button to apply the settings and close the dialog. 

– In the project tree the "RecvDataClient" DB is added to the "Program 
blocks" folder of the S7-300 CPU. 

– If the "Add new and open" function is enabled, the "RecvDataClient" DB 
opens in the working area of STEP 7 V16. 
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8. Alternatively, you can open the "RecvDataClient" DB in the working area of 
STEP 7 V16 by going in the project tree to the "Program blocks" folder of the 
S7-300 CPU and double-clicking the "RecvDataClient" DB. 
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9. In the DB "RecvDataClient” you define the variable "data" of the data type 
Array[0..199] of Byte. 

 

 

Add data block for saving the Send data 

The data that is transferred to the S7-1200 CPU is stored in data block 
DB2 "SendDataClient" of the S7-300 CPU. 

1. Add another DB for saving the Send data. 

2. In the "Add new block" dialog you click the "Data block (DB)" button. 

3. Enter the name of the DB, "SendDataClient", for example. 

4. Enable the "Automatic" option to have the number of the DB assigned 
automatically by STEP 7. 

5. Enable the "Add new and open" function. 

6. Click the "OK" button to apply the settings and close the dialog. 

– In the project tree the "SendDataClient" DB is added to the "Program 
blocks" folder of the S7-1200 CPU. 

– If the "Add new and open" function is enabled, the "SendDataClient" DB 
opens in the working area of STEP 7 V16. 
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7. Alternatively, you can open the "SendDataClient" DB in the working area of 
STEP 7 V16 by going in the project tree to the "Program blocks" folder of the 
S7-300 CPU and double-clicking the "SendDataClient" DB. 
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8. In the DB "SendDataClient” you define the variable "data" of the data type 
“Array[0..199] of Byte”. 

 

 

3.2.3 Create Variables for Parameters of Function Blocks "PutData" and 
"GetData" 

1. Add another DB to create variables for the parameters of function blocks 
"PutData" and "GetData". 

2. In the "Add new block" dialog you click the "Data block (DB)" button. 

3. Enter the name of the DB, "GeneralData", for example. 

4. Enable the "Automatic" option to have the number of the DB assigned 
automatically by STEP 7. 

5. Enable the "Add new and open" function. 

6. Click the "OK" button to apply the settings and close the dialog. 

– In the project tree the "GeneralData" DB is added to the "Program blocks" 
folder of the S7-300 CPU. 

– If the "Add new and open" function is enabled, the "GeneralData" DB 
opens in the working area of STEP 7 V16. 
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7. Alternatively, you can open the "GeneralData" DB in the working area of 
STEP 7 V16 by going in the project tree to the "Program blocks" folder of the 
S7-300 CPU and double-clicking the "GeneralData" DB. 

 

8. Create the following variables to assign the input and output parameters of the 
FBs "PutData" and "GetData". PLC data types are used as data type. 

Variable PLC data type Description 

put typePut Variables for parameterizing FB12 "PutData”. 

get typeGet Variables for parameterizing FB13 "GetData”. 

diagnostic typeDiagnostic Variables to store the status of FBs "PutData" and 
"GetData" in case of error. 
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PLC Data Type "typePut" 

The following table shows the structure of "typePut” data type. 

Table 3-1 

Parameter Data type Start value Description 

execute Bool false Control parameter for FB12 "PutData". 

connectionId Word 16#0 Addressing parameter for specifying the 
connection to the communication partner. 

done Bool false Status parameters 

busy Bool false Status parameters 

error Bool false Status parameters 

status Word 16#0 Status parameters 

 

PLC Data Type "typeGet" 

The following table shows the structure of the PLC data type "typeGet". 

Table 3-2 

Parameter Data type Start value Description 

execute Bool false Control parameter for FB13 "GetData". 

connectionId Word 16#0 Addressing parameter for specifying the 
connection to the communication partner. 

done Bool false Status parameters 

busy Bool false Status parameters 

error Bool false Status parameters 

status Word 16#0 Status parameters 

 

PLC Data Type "typeDiagnostic" 

The following table shows the structure of the "typeDiagnostic" data type. 

Table 3-3 

Parameter Data type Start value Description 

statusPut Word 16#0 Parameter to store the status of 
FB12 "PutData”. 

statusGet Word 16#0 Parameter to store the status of 
FB13 "GetData”. 
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3.2.4 Create a User Program 

Overview 

The following figure shows an overview of the user program in the S7-300 CPU 
and S7-1200 CPU. 

Figure 3-1 
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FB12 "PutData” 

The FB12 "PutData" calls the "PUT" instruction to execute the following functions: 

• Send data to the partner via the configured connection as soon as the input 
"execute" recognizes a positive edge. When the Write job is running, it is not 
possible to trigger a new Write job. 

• Output the status of the FB and data transmission at the "status" output. 

 

FB12 "PutData” is called cyclically in OB1. 

The following figure shows the call of the FB12 "PutData” in OB1. 

Figure 3-2 
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The following table shows the parameters of FB12 "PutData". 

Table 3-4 

Name P type Data type Comment 

execute IN Bool Control parameter: 

Enables the Write job on a rising edge. 

connectionId IN Word Local ID: 

Addressing parameter for specifying the connection to the 
partner CPU. 

Note 
The local ID is available in the Properties of the configured S7 
connection. 

The local ID 1 (hex) is used in this example. 

done OUT Bool TRUE: The Write job was executed error-free. 

busy OUT Bool TRUE: The Write job is running. 

error OUT Bool Status parameters "error" and "status": 

• "error" = 0: 

– "status" = 0000 (hex): neither warning nor error 

– "status" <> 0000 (hex): Warning 
The "status" parameter provides detailed information. 

• "error" = 1: An error has occurred. 
The "status" parameter provides detailed information 
about the type of error. 

status OUT Word 

ADDR_1 IN_OUT Any Pointer to the area to be written to in the partner CPU. 

Note 
The following parameters are hidden and are preset with the 
value "NULL”: 

• "ADDR_2" 

• "ADDR_3" 

• "ADDR_4" 

The following minimum user data size for the “PUT” instruction 
with 1 – 4 variables is guaranteed: 160 bytes 

ADDR_2 IN_OUT Any 

ADDR_3 IN_OUT Any 

ADDR_4 IN_OUT Any 

SD_1 IN_OUT Any Pointer to the area in your own S7 CPU that contains the data 
to be sent. 

Note 
The following parameters are hidden and are preset with the 
value "NULL”: 

• "SD_2" 

• "SD_3" 

• "SD_4" 

The following minimum user data size for the “PUT” instruction 
with 1 – 4 variables is guaranteed: 160 bytes 

SD_2 IN_OUT Any 

SD_3 IN_OUT Any 

SD_4 IN_OUT Any 
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Assign the variables created in section 3.2.3 to the parameters of FB12 "PutData”. 

The following table shows the assignment of the parameters of the "put” variable to 
the parameters of FB12 "PutData”. 

Table 3-5 

Parameters of 
FB12 "PutData" 

Parameters 
of the "put" 

variable 

Start value Note 

execute execute false Set the "execute” parameter to the 
value "TRUE" to start the Write job. 
The Write job is started on a rising 
edge. Reset the "execute" 
parameter to the value "FALSE" if 
the Write job is completed with 
"done" = true or "error" = true. 

connectionId connectionId 16#1 Enter the local ID of the connection 
that you defined during the 
connection configuration. 

done done false − 

busy busy false − 

error error false − 

status status 16#0 − 

ADDR_1 − P#DB1.DBX0.0 
BYTE 100. 

Only absolute addressing is 
permitted. 

SD_1 − P#DB2.DBX0.0 
BYTE 100 

− 
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FB13 "GetData" 

The FB13 "GetData" calls the "GET" instruction to execute the following functions: 

• Receive data from the partner via the configured connection as soon as the 
input "execute" recognizes a positive edge. When the Read job is running, it is 
not possible to trigger a new Read job. 

• Output the status of the FB and data transmission at the "status" output. 

 

FB13 "GetData” is called cyclically in OB1. 

The following figure shows the call of the FB13 "GetData” in OB1. 

Figure 3-3 
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The following table shows the parameters of FB13 "GetData”. 

Table 3-6 

Name P type Data type Comment 

execute IN Bool Control parameter: 

Enables the Read job on a rising edge. 

connectionId IN Word Local ID: 

Addressing parameter for specifying the connection to the 
partner CPU. 

Note 
The local ID is available in the Properties of the configured S7 
connection. 

The local ID 1 (hex) is used in this example. 

done OUT Bool TRUE: The Read job was executed error-free. 

busy OUT Bool TRUE: The read job is running. 

error OUT Bool Status parameters "error" and "status": 

• "error" = 0: 

– "status" = 0000 (hex): neither warning nor error 

– "status" <> 0000 (hex): Warning 
The "status" parameter provides detailed information. 

• "error" = 1: An error has occurred. 
The "status" parameter provides detailed information 
about the type of error. 

status OUT Word 

ADDR_1 IN_OUT Any Pointer to the area to be read in the partner CPU. 

Note 
The following parameters are hidden and are preset with the 
value "NULL”: 

• "ADDR_2" 

• "ADDR_3" 

• "ADDR_4" 

The following minimum user data size for the “GET” instruction 
with 1 – 4 variables is guaranteed: 160 bytes 

ADDR_2 IN_OUT Any 

ADDR_3 IN_OUT Any 

ADDR_4 IN_OUT Any 

RD_1 IN_OUT Any Pointer to the area in your own S7 CPU in which the read data 
is stored. 

Note 
The following parameters are hidden and are preset with the 
value "NULL”: 

• "RD_2" 

• "RD_3" 

• "RD_4" 

The following minimum user data size for the “GET” instruction 
with 1 – 4 variables is guaranteed: 160 bytes 

RD_2 IN_OUT Any 

RD_3 IN_OUT Any 

RD_4 IN_OUT Any 
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Assign the variables created in section 3.2.3 to the parameters of FB13 "GetData”. 

The following table shows the assignment of the parameters of the "get” variable to 
the parameters of FB13 "GetData”. 

Table 3-7 

Parameters of 
FB13 "GetData" 

Parameters 
of the "get" 

variable 

Start value Note 

execute execute false Set the "execute” parameter to the 
value "TRUE" to start the Read job. 
The Read job is started on a rising 
edge. Reset the "execute" 
parameter to the value "FALSE" if 
the Read job is completed with 
"done" = true or "error" = true. 

connectionId connectionId 16#100 Enter the local ID of the connection 
that you defined during the 
connection configuration. 

done done false − 

busy busy false − 

error error false − 

status status 16#0 − 

ADDR_1 − P#DB4.DBX0.0 
BYTE 100 

Only absolute addressing is 
permitted. 

RD_1 − P#DB1.DBX0.0 
BYTE 100 

− 
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3.3 Install SIMATIC S7-300 as Server 

3.3.1 Create Send and Receive Data Areas 

In the user program of the S7-300 CPU you add the data blocks for saving the 
Send and Receive data. 

Add data block for saving the Receive data 

1. In the project tree you navigate to the device folder of the S7-300 CPU. 
The device folder contains structured objects and actions that belong to the 
device. 

2. In the device folder you navigate to the "Program blocks" subfolder and 
double-click the "Add new block" action. 
The "Add new block" dialog opens. 

 

3. Click the "Data block (DB)" button. 

4. Enter the name of the data block (DB), "RecvDataServer", for example. 

5. Enable the "Automatic" option to have the number of the DB assigned 
automatically by STEP 7. 

6. Enable the "Add new and open" function. 

7. Click the "OK" button to apply the settings and close the dialog. 

– In the project tree the "RecvDataServer" DB is added to the "Program 
blocks" folder of the S7-300 CPU. 

– If the "Add new and open" function is enabled, the "RecvDataServer" DB 
opens in the working area of STEP 7 V16. 
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8. Alternatively, you can open the "RecvDataServer" DB in the working area of 
STEP 7 V16 by going in the project tree to the "Program blocks" folder of the 
S7-300 CPU and double-clicking the "RecvDataServer" DB. 
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9. In the DB "RecvDataServer” you define the variable "data" of the data type 
“Array[0..199] of Byte”. 

 

 

Add data block for saving the Send data 

1. Add another DB for saving the Send data. 

2. In the "Add new block" dialog you click the "Data block (DB)" button. 

3. Enter the name of the DB, "SendDataServer", for example. 

4. Enable the "Automatic" option to have the number of the DB assigned 
automatically by STEP 7. 

5. Enable the "Add new and open" function. 

6. Click the "OK" button to apply the settings and close the dialog. 

– In the project tree the "SendDataServer" DB is added to the "Program 
blocks" folder of the S7-300 CPU. 

– If the "Add new and open" function is enabled, the "SendDataServer" DB 
opens in the working area of STEP 7 V16. 
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7. Alternatively, you can open the "SendDataServer" DB in the working area of 
STEP 7 V16 by going in the project tree to the "Program blocks" folder of the 
S7-300 CPU and double-clicking the "SendDataServer" DB. 

 

8. In the DB "SendDataServer” you define the variable "data" of the data type 
“Array[0..199] of Byte”. 
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3.4 Download the Hardware Configuration and User 
Program 

Requirements 

You have already assigned the configured IP address and subnet mask to the 
S7-300 CPU and possibly the CP. 

Compile 

1. In the project tree you mark the device folder of the S7-300 CPU. 

2. Click the "Compile" button in the toolbar. The hardware configuration and the 
software of the S7-300 are compiled. 
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Download 

1. In the project tree you mark the device folder of the S7-300 CPU. 

2. Click the "Download to device" button in the toolbar. The "Extended download 
to device" or "Load preview" dialog opens automatically. 

 

3. The "Extended download to device" dialog opens automatically only if the 
access path from the PG/PC to the S7-300 CPU has to be set. Make the 
following settings: 

– Type of the PG/PC interface: PN/IE 

– PG/PC interface: Network card of the PG/PC 

– Connection to interface/subnet: Subnet to which the S7-300 CPU is 
connected 

4. In the drop-down list box, you select "Show all compatible devices". 

5. Click "Start Search". 

6. The S7-300 CPU is displayed in the "Select target device:" list. Mark the 
S7-300 CPU. 

7. Click the "Load" button. 
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8. In the "Load preview" dialog you click the "Load" button to start the loading 
procedure. 

 

9. In the "Load results" dialog you enable the "Start module" action and click the 
"Finish" button to terminate the loading procedure. 
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4 Configuration of SIMATIC S7-300 in 
STEP 7 V5.6 
1. Create a new project or open an existing project in STEP 7 V5.6. 

2. Add an S7-300 station and create the hardware configuration. 

3. Install the S7-300 CPU as client or server. 

– Client: Configure a new S7 connection and create the user program. In the 
user program you call the "PUT" instruction to write data to the S7-300 
CPU. In the user program you call the "GET" instruction to read data from 
the S7-300 CPU. Add the data blocks for saving the Send and Receive 
data. 

– Server: Create the user program. In the user program you add data blocks 
in which the sent and received data is stored. 

4.1 Create the Hardware Configuration 

4.1.1 Open the Hardware Configuration 

1. In the SIMATIC Manager you mark the SIMATIC S7-300 station that you have 
added to your STEP 7 project. 

2. Double-click the "Hardware" item. The Hardware Configuration opens. 
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3. Drag and drop the relevant modules like Power Supply, CPU, CP etc. from the 
hardware catalog into the S7-300 profile channel. 
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4.1.2 Define IP Address and Assign Subnet to the PROFINET interface of 
the CPU 

1. Double-click the PROFINET interface of the S7-300 CPU. The Properties 
dialog of the PROFINET interface opens. 

 

2. Click the "Properties" button to change the IP address and subnet mask and 
assign the subnet. 
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3. Enter the IP address and subnet mask, for example: 

– IP address: 172.16.43.37 

– Subnet mask: 255.255.0.0 

4. Click the "New..." button to create a new subnet. 

5. Select the new subnet or another existing subnet. 

6. Click the "OK" button to apply the IP address and subnet mask and assign the 
selected subnet to the PROFINET interface of the S7-300 CPU. 

Unrestricted
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4.1.3 Define IP Address and Assign Subnet to the PROFINET interface of 
the CP 

1. Double-click the PROFINET interface of the CP. The Properties dialog of the 
PROFINET interface opens. 

2. Click the "Properties" button to change the IP address and subnet mask and 
assign the subnet. 

 

3. Enter the IP address and subnet mask, for example: 

– IP address: 172.16.43.41 

– Subnet mask: 255.255.0.0 

4. Click the "New..." button to create a new subnet. 

5. Select the new subnet or another existing subnet. 

6. Click the "OK" button to apply the IP address and subnet mask and assign the 
selected subnet to the PROFINET interface of the CP. 
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Unrestricted
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4.2 Configure the SIMATC S7-300 as Client 

The S7-300 station actively sets up the S7 connection. In this case you must 
configure an S7 connection for the S7-300 CPU and call the following function 
blocks (FBs) in the user program: 

• FB14 "GET": You use FB14 "GET" to read data from a partner CPU. With an 
S7-400 CPU you use the system function block SFB14 "GET". 

• FB15 "PUT": You use FB15 "PUT" to write data to a partner CPU. With an S7-
400 CPU you use the system function block SFB15 "PUT". 

4.2.1 Configuration of the S7 Connection 

Add an S7 Connection 

1. In the SIMATIC Manager you open the "NetPro" tool via the menu "Options > 
Configure Network". In "NetPro" you configure the S7 connection for the 
S7-300 CPU. 

 

2. Mark the CPU in the SIMATIC S7-300 station. 

3. Open the "Insert New Connection" dialog via the menu "Insert > New 
Connection...". 
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4. Select the "Unspecified" item under "Connection Partner". 

5. Select "S7 connection" as the connection type. 

6. Click "Apply". The Properties dialog of the S7 connection opens. 
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Define connection parameters 

In the Properties dialog of the S7 connection you define the connection 
parameters. 

1. Enable the "Establish an active connection" function. 

2. Select the local interface. In this example, the integrated interface of the 
S7-300 CPU is used. If the S7 connection is to be established via a CP, select 
the CP. 

3. Enter the IP address of the partner CPU. In this example you enter the 
IP address of the S7-1200 CPU: 172.16.43.2.  
If you use a CP as partner instead of the integrated interface of the S7-1200 
CPU, enter the IP address of the CP. 

4. You specify the local ID of the connection in the user program at the input 
parameter "ID" of the function blocks FB/SFB14 "GET" and FB/SFB15 "PUT". 

5. Click the "Address Details..." button. The "Address Details" dialog opens. 
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6. Enter the rack and slot of the partner CPU or CP. The S7-1200 CPU uses 
Rack 0 and Slot 1. 

7. Select the connection resource 03(hex) for the partner CPU because the S7 
connection is only configured unilaterally in the S7-300 CPU. With these 
settings the TSAP has the value 03.01 in the partner CPU. 

8. Apply the settings with "OK". 

 

9. Likewise apply the settings in the Properties dialog of the S7 connection with 
"OK". 

10. In the "Insert New Connection" dialog you click the "OK" button to close the 
dialog. The S7 connection is inserted in "NetPro". 
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Load the S7 Connection 

1. In "NetPro" you mark the S7 CPU in the SIMATIC S7-300 station. 
The connection table shows all the connections configured for the S7-CPU. 

 

2. In "NetPro" you mark the SIMATIC S7-300 station. 

3. In the toolbar you click the "Save and Compile" button to save and compile the 
connection configuration. 

4. In the toolbar you click the "Load marked station(s)" button to load the 
connection configuration into the S7 CPU. 

 

 



4 Configuration of SIMATIC S7-300 in STEP 7 V5.6 

 

S7 communication between SIMATIC S7-1200 and SIMATIC S7-300 
with PUT/GET 
Entry-ID: 82212115,    V 3.0,    11/2020   76 
 

©
 S

ie
m

e
n

s
 A

G
 2

0
2

0
 A

ll 
ri

g
h

ts
 r

e
s
e

rv
e

d
 

4.2.2 Create Send and Receive Data Areas 

Add data block for saving the Receive data 

The data received from the S7-1200 CPU is stored in data block DB1 
"RecvDataClient" of the S7-300 CPU. 

1. In your STEP 7 project you right-click the "Blocks" folder. The pop-up menu 
opens. 

2. You select the menu "Insert New Object > Data Block". The Properties dialog 
of the DB opens. 

 

3. You enter the name and type of block that is to be created, DB1, for example. 

4. Enter a symbolic name for the block, "RecvDataClient", for example. 

5. Apply the settings with "OK". 
Block DB1 "RecvDataClient” is added to the "Blocks" folder. 
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6. Double-click DB1 "RecvDataClient” in the "Blocks" folder. 
The DB opens. 

 

7. In the DB "RecvDataClient” you define the variable "data" of the data type 
“Array[0..199] of Byte”. 
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Add data block for saving the Send data 

The data that is transferred to the S7-1200 CPU is stored in data block DB2 
"SendDataClient" of the S7-300 CPU. 

1. Add another DB for saving the Send data. 

2. You enter the name and type of block that is to be created, DB2, for example. 

3. Enter a symbolic name for the block, "SendDataClient", for example. 

4. Apply the settings with "OK". 
Block DB2 "SendDataClient” is added to the "Blocks" folder. 
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5. Double-click DB2 "SendDataClient” in the "Blocks" folder. 
The DB opens. 

 

6. In the DB2 "SendDataClient” you define the variable "data" of the data type 
“Array[0..99] of Byte”. 

 

 

4.2.3 Create Variables for Parameters of Function Blocks "PutData" and 
"GetData" 

1. Add another DB to create variables for the parameters of function blocks 
"PutData" and "GetData". 

2. You enter the name and type of block that is to be created, DB10, for example. 

3. Enter a symbolic name for the block, "GeneralData", for example. 

4. Apply the settings with "OK". 
Block DB10 "GeneralData” is added to the "Blocks" folder. 



4 Configuration of SIMATIC S7-300 in STEP 7 V5.6 

 

S7 communication between SIMATIC S7-1200 and SIMATIC S7-300 
with PUT/GET 
Entry-ID: 82212115,    V 3.0,    11/2020   80 
 

©
 S

ie
m

e
n

s
 A

G
 2

0
2

0
 A

ll 
ri

g
h

ts
 r

e
s
e

rv
e

d
  

5. Create the following variables to assign the input and output parameters of the 
FBs "PutData" and "GetData". UDTs are used as data types. 

Variable UDT Description 

put UDT1 "typePut" Variables for parameterizing 
FB1 "PutData”. 

get UDT2 "typeGet" Variables for parameterizing 
FB2 "GetData”. 

diagnostic UDT3 "typeDiagnostic" Variables to store the status of FBs 
"PutData" and "GetData" in case of error. 

 

UDT1 "typePut" 

The following table shows the structure of UDT1 "typePut". 

Table 4-1 

Parameter Data type Start value Description 

execute Boolean false Control parameter for FB1 "PutData". 

connectionId Word 16#0 Addressing parameter for specifying the 
connection to the communication partner. 

done Bool false Status parameters 

busy Bool false Status parameters 

error Bool false Status parameters 

status Word 16#0 Status parameters 
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UDT2 "typeGet" 

The following table shows the structure of UDT2 "typeGet”. 

Table 4-2 

Parameter Data type Start value Description 

execute Bool false Control parameter for FB2 "GetData". 

connectionId Word 16#0 Addressing parameter for specifying the 
connection to the communication partner. 

done Bool false Status parameters 

busy Bool false Status parameters 

error Bool false Status parameters 

status Word 16#0 Status parameters 

 

UDT3 "typeDiagnostic" 

The following table shows the structure of UDT3 "typeDiagnostic”. 

Table 4-3 

Parameter Data type Start value Description 

statusPut Word 16#0 Parameter to store the status of 
FB1 "PutData”. 

statusGet Word 16#0 Parameter to store the status of 
FB2 "GetData”. 
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4.2.4 Create a User Program 

In the user program of the S7-300 CPU you call the function blocks FB14 "GET" 
and FB15 "PUT" for data transfer.  

If you are using the integrated PROFINET interface of the S7-300 CPU for data 
communication via S7 connections, then utilize function blocks FB14 "GET" and 
FB15 "PUT" from the Standard Library under “Communication Blocks -> Blocks" 
with the family "CPU_300". 

If you are using an Industrial Ethernet CP or PROFIBUS CP for data 
communication via S7 connections in the S7-300 station, then utilize the function 
blocks FB14 "GET" and FB15 "PUT" from the "SIMATIC_NET_CP" library under 
"CP 300 > Blocks". 

Copy the FBs from the Standard Library or from the "SIMATIC_NET_CP” library 
and insert them in your STEP 7 project. 

 

Note The system function blocks SFB14 "GET" and SFB15 "PUT" for the S7-400 are 
located in the Standard Library under "System Function Blocks". 

 



4 Configuration of SIMATIC S7-300 in STEP 7 V5.6 

 

S7 communication between SIMATIC S7-1200 and SIMATIC S7-300 
with PUT/GET 
Entry-ID: 82212115,    V 3.0,    11/2020   83 
 

©
 S

ie
m

e
n

s
 A

G
 2

0
2

0
 A

ll 
ri

g
h

ts
 r

e
s
e

rv
e

d
 

The following figure shows the block calls in the S7-300 CPU and S7-1200 CPU. 

Figure 4-1 

User

program

Function blocks

Data blocks

Data blocks

Write

data

Read

data

S7-300 CPU

S7-1200 CPU

Main [OB1] 

PutData

[FB1]

GetData

[FB2]

PUT GET

SendData

Client [DB2]

RecvData

Client [DB1]

RecvData
Server 
[DB3]

SendData
Server 
[DB4]
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FB1 "PutData" 

The FB1 "PutData" calls the FB15 "PUT" to execute the following functions: 

• Send data to the partner via the configured connection as soon as the input 
"execute" recognizes a positive edge. When the Write job is running, it is not 
possible to trigger a new Write job. 

• Output the status of the FB and data transmission at the "status" output. 

 

FB1 "PutData” is called cyclically in OB1. 

The following figure shows the call of the FB1 "PutData” in OB1. 

Figure 4-2 
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FB1 "PutData” has the following parameters. 

Table 4-4 

Name P type Data type Comment 

execute IN Bool Control parameter: 

Enables the Write job on a rising edge. 

connectionId IN Word Reference to the local connection description (preset by the 
connection configuration in in "NetPro"). 

In this example the value w#16#1 is preset by the configuration 
connection. 

done OUT Bool TRUE: The Write job was executed error-free. 

busy OUT Bool TRUE: The Write job is running. 

error OUT Bool Status parameters "error" and "status": 

• "error" = 0: 

– "status" = 0000 (hex): neither warning nor error 

– "status" <> 0000 (hex): Warning 
The "status" parameter provides detailed information. 

• "error" = 1: An error has occurred. 
The "status" parameter provides detailed information about 
the type of error. 

status OUT Word 

 

Assign the variables created in section 4.2.3 to the parameters of FB1 "PutData”. 

The following table shows the assignment of the parameters of the "put” variable to 
the parameters of FB1 "PutData”. 

Table 4-5 

Parameters of 
FB1 "PutData" 

Parameters 
of the "put" 

variable 

Start value Note 

execute execute false Set the "execute” parameter to the 
value "TRUE" to start the Write job. 
The Write job is started on a rising 
edge. Reset the "execute" parameter 
to the value "FALSE" if the Write job 
is completed with "done" = true or 
"error" = true. 

connectionId connectionId 16#1 Enter the local ID of the connection 
that you defined during the 
connection configuration. 

done done false − 

busy busy false − 

error error false − 

status status 16#0 − 
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Open FB1 "PutData” to define the Receive and Send data areas in FB15 "PUT". 

Receive data area 

At input "ADDR_1" of FB15 "PUT" you refer to the area in the partner CPU 
(S7-1200 CPU, for example) to which you want to write. 

• P#DB1.DBX0.0 BYTE 100. 

 

Note The following minimum user data size for the "PUT" instruction is guaranteed: 
160 bytes 

 

Send data area 

At input "SD_1" of FB15 "PUT" you refer to the area in your own S7 CPU (S7-300 
CPU) that contains the data to be sent. 

• P#DB2.DBX0.0 BYTE 100 

 

Note The following minimum user data size for the "PUT" instruction is guaranteed: 
160 bytes 
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FB 2 "GetData" 

The FB2 "GetData" calls the "GET" instruction to execute the following functions: 

• Receive data from the partner via the configured connection as soon as the 
input "execute" recognizes a positive edge. When the Read job is running, it is 
not possible to trigger a new Read job. 

• Output the status of the FB and data transmission at the "status" output. 

 

FB2 "GetData” is called cyclically in OB1. 

The following figure shows the call of the FB2 "GetData” in OB1. 

Figure 4-3 
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FB2 "PutData” has the following parameters. 

Table 4-6 

Name P type Data type Comment 

execute IN Bool Control parameter: 

Enables the Read job on a rising edge. 

connectionId IN Word Reference to the local connection description (preset by the 
connection configuration in in "NetPro"). 

In this example the value w#16#1 is preset by the 
configuration connection. 

done OUT Bool TRUE: The Read job was executed error-free. 

busy OUT Bool TRUE: The read job is running. 

error OUT Bool Status parameters "error" and "status": 

• "error" = 0: 

– "status" = 0000 (hex): neither warning nor error 

– "status" <> 0000 (hex): Warning 
The "status" parameter provides detailed information. 

• "error" = 1: An error has occurred. 
The "status" parameter provides detailed information 
about the type of error. 

status OUT Word 

 

Assign the variables created in section 4.2.3 to the parameters of FB2 "GetData”. 

The following table shows the assignment of the parameters of the "get” variable to 
the parameters of FB2 "GetData”. 

Table 4-7 

Parameters of 
FB2 "GetData" 

Parameters 
of the "get" 

variable 

Start value Note 

execute execute false Set the "execute” parameter to the 
value "TRUE" to start the Read job. 
The Read job is started on a rising 
edge. Reset the "execute" parameter to 
the value "FALSE" if the Read job is 
completed with "done" = true or 
"error" = true. 

connectionId connectionId 16#1 Enter the local ID of the connection 
that you defined during the connection 
configuration. 

done done false − 

busy busy false − 

error error false − 

status status 16#0 − 
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Open FB2 "GetData” to define the Receive and Send data areas in FB14 "GET". 

Send data area 

At input "ADDR_1" of FB14 "GET" you refer to the area in the partner CPU 
(S7-1200 CPU, for example) which you want to read. 

• P#DB4.DBX0.0 BYTE 100 

 

Note The following minimum user data size for the "GET" instruction is guaranteed: 
160 bytes 

 

Receive data area 

At input "RD_1" of FB14 "GET” you refer to the area in your own S7 CPU (S7-300 
CPU) that contains the data to be read. 

• P#DB1.DBX0.0 BYTE 100 

 

Note The following minimum user data size for the "GET" instruction is guaranteed: 
160 bytes 
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4.3 Configure the SIMATC S7-300 as Server 

4.3.1 Create a User Program 

In the user program of the S7-300 CPU you add the data blocks for saving the 
Send and Receive data. 

Add data block for saving the Send data 

1. In your STEP 7 project you right-click the "Blocks" folder. The pop-up menu 
opens. 

2. You select the menu "Insert New Object > Data Block". The Properties dialog 
of the DB opens. 

 

3. You enter the name and type of block that is to be created, DB4, for example. 

4. Enter a symbolic name for the block, "SendDataServer", for example. 

5. Apply the settings with "OK". 
Block DB4 "SendDataServer” is added to the "Blocks" folder. 
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6. Double-click DB4 "SendDataServer” in the "Blocks" folder. 
The DB opens. 
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7. In the DB4 "SendDataServer” you define the variable "data" of the data type 
“Array[0..199] of Byte”. 

 

 

Add data block for saving the Receive data 

1. Add another DB for saving the Receive data. 

2. You enter the name and type of block that is to be created, DB3, for example. 

3. Enter a symbolic name for the block, "RecvDataServer", for example. 

4. Apply the settings with "OK". 
Block DB3 "RecvDataServer” is added to the "Blocks" folder. 

 

5. Double-click DB3 "RecvDataServer” in the "Blocks" folder. 
The DB opens. 
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6. In the DB3 "RecvDataServer” you define the variable "data" of the data type 
“Array[0..99] of Byte”. 
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4.4 Download the Hardware Configuration and User 
Program 

Requirements 

You have already assigned the configured IP address and subnet mask to the 
S7-300 CPU. 

Instructions 

1. In the SIMATIC Manager, you select the menu "Options > Set PG/PC 
Interface...". The "Set PG/PC Interface" dialog opens. 

 

2. As access point for the application you set the network card with TCP/IP 
protocol via which the PC is connected to the S7-300 CPU and via which you 
access the S7-300 CPU. 

3. Apply the settings with "OK". 
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4. In the SIMATIC Manager you mark the S7-300 station. 

5. Click the "Load" button in the toolbar. The hardware configuration and the user 
program are downloaded to the S7-300 CPU. 

 

 



5 Error Handling 
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5 Error Handling 

5.1 FB "PutData" 

If an error occurs in FB "PutData”, the cause of the error is written to the "status" 
output parameter. 

Table 5-1 

error status Description Remedy 

0 16#7000 FB "PutData" is not 
active. 

Status information 

Enable FB "PutData” by setting the 
"execute" input to "true". 

0 16#7001 FB "PutData" is 
initialized. 

Status information 

0 16#7002 Write job is running. Status information 

1 <>16#0000 Status display of the 
"PUT” instruction. 

Detailed information is available in the 
STEP 7 Online Help or in the following 
manuals: 

• "SIMATIC STEP 7 
Basic/Professional V16 and 
SIMATIC WinCC V16". 

• SIMATIC System Software for S7-
300/400 System and Standard 
Functions - Volume 1/2 

 

5.2 FB "GetData" 

If an error occurs in FB "GetData”, the cause of the error is written to the "status" 
output parameter. 

 

Table 5-2 

error status Description Remedy 

0 16#7000 FB "GetData" is not 
active. 

Status information 

Enable FB "GetData” by setting the 
"execute" input to "true". 

0 16#7001 FB "GetData" is 
initialized. 

Status information 

0 16#7002 Read job is running. Status information 

1 <>16#0000 Status display of the 
"GET” instruction. 

Detailed information is available in the 
STEP 7 Online Help or in the following 
manuals: 

• "SIMATIC STEP 7 
Basic/Professional V16 and 
SIMATIC WinCC V16". 

• SIMATIC System Software for S7-
300/400 System and Standard 
Functions - Volume 1/2 

 

https://support.industry.siemens.com/cs/ww/en/view/109773506
https://support.industry.siemens.com/cs/ww/en/view/109773506
https://support.industry.siemens.com/cs/ww/en/view/109773506
https://support.industry.siemens.com/cs/ww/en/view/109751826
https://support.industry.siemens.com/cs/ww/en/view/109751826
https://support.industry.siemens.com/cs/ww/en/view/109751826
https://support.industry.siemens.com/cs/ww/en/view/109773506
https://support.industry.siemens.com/cs/ww/en/view/109773506
https://support.industry.siemens.com/cs/ww/en/view/109773506
https://support.industry.siemens.com/cs/ww/en/view/109751826
https://support.industry.siemens.com/cs/ww/en/view/109751826
https://support.industry.siemens.com/cs/ww/en/view/109751826
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6 Operating and Monitoring 
Operating and monitoring is done via a variable table in STEP 7 V5.6 and STEP 7 
V16. 

• "Client”: 

– The variable table is for starting the Read job and for monitoring the data 
that the S7 CPU as client reads from the server. 

– The variable table is for starting the Write job and for monitoring the data 
that the S7 CPU writes to the server. 

• "Server": 

– The variable table is for monitoring the data that the S7 CPU as server 
receives from the client. 

– The variable table is for controlling the data that the client reads from the 
S7 CPU. 

6.1 SIMATIC S7-1200 Writes and Reads Data as Client 

6.1.1 Write Data to the S7-300 

1. In STEP 7 V16 you open the device folder of the S7-1200 CPU. 

2. In the project tree you open the device folder of the S7-1200 CPU. 

3. In the "Watch and force tables" folder you double-click the variable 
table "Client". 
The variable table opens in the working area of STEP 7 V16. 
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4. Click the "Monitor all" button in the toolbar. 
The "Monitor value" column displays the current values stored in the Send data 
area (DB1) and Receive data area (DB2). 

5. In the "Modify value" column you enter the values that are to be put in the 
Send data area (DB2) of the S7-1200 CPU and written to the S7300 CPU. 

6. Set the “GeneralData” variable to the value "True" to start the Write job. 
Note 
The variable "GeneralData".put.execute is reset to the value "False" in the user 
program as soon as the Write job is completed with "done" = true or "error" = 
true. 

7. In the toolbar you click the "Modify all enabled values once and immediately" 
button. 

 

 

Result 

The modified values are put in the Send data area (DB1) of the S7-1200 CPU and 
written to the S7-300 CPU. 
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6.1.2 Read Data from the S7-300 

1. In STEP 7 V16 you open the S7-1200 CPU project. 

2. In the project tree you open the device folder of the S7-1200 CPU. 

3. In the "Watch and force tables" folder you double-click the variable 
table "Client". 
The variable table opens in the working area of STEP 7 V16. 

 

4. Click the "Monitor all" button in the toolbar. The "Status value" column displays 
the current values stored in the Send data area (DB2) and Receive data area 
(DB1). 

5. Set the “GeneralData” variable to the value "True" to start the Read job. 
Note 
The variable "GeneralData".get.execute is reset to the value "False" in the user 
program as soon as the Read job is completed with "done" = true or "error" = 
true. 

6. In the toolbar you click the "Modify all enabled values once and immediately" 
button. 
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Result 

The "Monitor value" column displays the data read from the S7-300 and stored in 
the Receive data area (DB1). 
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6.2 SIMATIC S7-300 Writes and Reads Data as Client 
(STEP 7 V16) 

6.2.1 Write Data to the S7-1200 

1. In STEP 7 V16 you open the S7-300 CPU project. 

2. In the project tree you open the device folder of the S7-300 CPU. 

3. In the "Watch and force tables" folder you double-click the variable 
table "Client". 
The variable table opens in the working area of STEP 7 V16. 

 

4. Click the "Monitor all" button in the toolbar. 
The "Monitor value" column displays the current values stored in the Send data 
area (DB1) and Receive data area (DB2). 

5. In the "Modify value" column you enter the values that are to be put in the 
Send data area (DB2) of the S7-300 CPU and written to the S7-1200 CPU. 

6. Set the “GeneralData” variable to the value "True" to start the Write job. 
Note 
The variable "GeneralData".put.execute is reset to the value "False" in the user 
program as soon as the Write job is completed with "done" = true or "error" = 
true. 

7. In the toolbar you click the "Modify all enabled values once and immediately" 
button. 
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Result 

The modified values are put in the Send data area (DB1) of the S7-300 CPU and 
written to the S7-1200 CPU. 
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6.2.2 Read Data from the S7-1200 

1. In STEP 7 V16 you open the S7-300 CPU project. 

2. In the project tree you open the device folder of the S7-300 CPU. 

3. In the "Watch and force tables" folder you double-click the variable 
table "Client". 
The variable table opens in the working area of STEP 7 V16. 

 

4. Click the "Monitor all" button in the toolbar. The "Status value" column displays 
the current values stored in the Send data area (DB2) and Receive data area 
(DB1). 

5. Set the “GeneralData” variable to the value "True" to start the Read job. 
Note 
The variable "GeneralData".get.execute is reset to the value "False" in the user 
program as soon as the Read job is completed with "done" = true or "error" = 
true. 

6. In the toolbar you click the "Modify all enabled values once and immediately" 
button. 
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Result 

The "Monitor value" column displays the data read from the S7-300 and stored in 
the Receive data area (DB1). 
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6.3 SIMATIC S7-300 Writes and Reads Data as Client 
(STEP 7 V5.6) 

6.3.1 Write Data to the S7-1200 CPU 

1. In STEP 7 V5.6 you open the S7-300 CPU project. 

2. In the "Blocks" folder you double-click the variable table "Client". The variable 
table opens. 

 

3. Click the "Monitor variable" button in the toolbar. The "Status value" column 
displays the current values stored in the Send data area (DB2) and Receive 
data area (DB1). 

4. In the "Modify value" column you enter the values that are to be put in the 
Send data area (DB2) of the S7-300 CPU and written to the S7-1200 CPU. 

5. Set the “GeneralData” variable to the value "True" to start the Write job. 
Note 
The variable "GeneralData".put.execute is reset to the value "False" in the user 
program as soon as the Write job is completed with "done" = true or "error" = 
true. 

6. Click the "Activate modify values" button in the toolbar. 
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Result 

The modified values are put in the Send data area (DB1) of the S7-300 CPU and 
written to the S7-1200 CPU. 
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6.3.2 Read Data from the S7-1200 CPU 

1. In STEP 7 V5.6 you open the S7-300 CPU project. 

2. In the "Blocks" folder you double-click the variable table "Client". The variable 
table opens. 

 

3. Click the "Monitor variable" button in the toolbar. The "Status value" column 
displays the current values stored in the Send data area (DB2) and Receive 
data area (DB1). 

4. Set the “GeneralData” variable to the value "True" to start the Read job. 
Note 
The variable "GeneralData".get.execute is reset to the value "False" in the user 
program as soon as the Read job is completed with "done" = true or "error" = 
true. 
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5. Click the "Activate modify values" button in the toolbar. 

 

 

Result 

The "Status value" column displays the data read from the S7-1200 and stored in 
the Receive data area (DB1). 
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